www.risottostudio.com




CONTENTS

INTRO / HOW IT WORKS -=-=====--- 3
APPLICATIONS =-=-=-=-=-------=-oo-- 4
INKS / COLOURS ----=-=-=-=-=------ 5
OVERLAY ------------mmmmmmn- 6
METALLIC GOLD - -=--==-==--=--- 7
Y R ——— 8
PREPARING FILES + GLITCHES ---- - - - 9
COMMON PROBLEMS - - - === - === - - 10
FLATTENING FILES --------=----- 11
A3 LAYOUT == - — == - - - oo oo - 12
CARD + FLYER LAYOUT --------- 13-14
TRIMMING OPTIONS - - - === = == == - - 15
NAMING FILES - == - = - === === - - 16
OPACITIES - = === === == -==o-mmom- 17

INK COVERAGE - - == === ===~ === - - 18
INK COVERAGE CONT. - == -===-===-- 19
GRADIENTS -==--=--=----ooou--- 20
TEXT / TYPE- === - - - oo oo o - 21
STENCILS - - === === == -=-=—=—=—=- 22
STENCIL FORMATS == === === -==-- - 23
IMPERFECTIONS - == == === === - - - 24
SUSTAINABILITY = === - == === == - - 25
PRCING == =========c-coceomnom- 26
QUOTES + EXTRA SERVICES -------- 27
TURN AROUND - - - = - - === - = - - - 28
AMENDMENTS + PROBLEMS ------- 29
TERMS + CONDITIONS - - - = = = = = = - - 30
PRINT DISCLAIMER / VISITATION - - -31
BOOKLET GUIDE  ------===--==- 32-38



Masters of the A3; RISOTTO produce vibrant prints for a range
of clients, from leading art organisations to bands and brands;
quickly, & creatively.

Years of gathered experience, coupled with in-house
production allows RISOTTO to offer bespoke services with a
strong focus on design.

So, whether you're looking to print an art edition, master a
technical print challenge, or get posters pimped up - get in
touch!

The RISO works by transforming your
artwork into a stencil. Your chosen
colour drum is then inserted into the
riso machine, and the stencil is
wrapped tightly around it.

Paper is fed flat through the machine,
passing under the rotating drum,
which transfers your artwork onto
the paper at high speed.

FEED TIRE

———— ——— ——— ——— ——— - >

It looks like a photocopier and moves as fast as one, but works
as a screenprinter; using rich spot colours and stencils to
create tactile and vibrant prints, affordably and with little
impact to our environment.

Stencils are made specifically for
each drum and are non transferable.

One colour is printed at a time, and
multicoloured prints are created by
switching out drums, then over
printing; passing the paper through
the RISO again and again!

PRINTS




W E P R I N I A3 Risograph printing was originally designed for
high-volume printing in places like offices, schools
and political parties, but in the last 5 years, it has

The riso is an A3 printer - so everything is sent on A3 sized stencils, undergone a resurgence with creatives adopting the
and printed on A3 paper. Finishing services can be applied to create process because of its quick and colourful results at

some of the following applications: affordable prices.

The riso was designed to bridge the gap between
cheap and expensive print methods (from the
photocopy to offset/litho), which makes it ideal for
quantities of 1-2000 prints, become most cost
effective at 25+ prints.

POSTERS + FLYERS
BUS'N ESS CARDS The process is great for graphic art (vector based work),

typography, and illustration, but also works wonders across

ART PRINTS + EDITIONS painting and photography, using variations of CMYK.
MENUS + PLACE MATS
-

PROGRAMMES + MAPS
FOLDED CARDS + ENVELOPES

PAPER BAGS + WRAP

TAPE COVERS + VINYL INSERTS o iobs that will require finishing serv
or JODS at Will require mnisning services.
STICKERS + SWING TAGS TRIMMING | BINDING | FOLDING | COLLATING

We can either offer some services in house, otherwise it

ZINES + PUBLICATIONS will be over to you to take the A3 prints onto another

specialist to be finished.




YELLOW U SUNFLOWER 116 U ORANGE 021U WARM RED U BURGUNDY 235 U PURPLE 2685 U VIOLET 265 U

The RISO inks produce a
unique texture, resulting in a
tactile finish.

The inks are soy-based and
non-toxic, which means they
can take longer to dry. The ink
sits on the surface of the paper
and can therefore be prone to
smudging if handled a lot (like
newspaper).

All inks are unique to the riso TEAL 321U HUNTER GREEN 342 U GREEN 354U MINT 324 U AQUA BLUE 312 U MEDIUM BLUE 286 U FEDERAL BLUE 294 U

process and colours produced
cannot be represented on the
web or through digital print
(especially our fluro and
metallic inks!) giving you a
unique print results.

Print samples are sent out
regularly, as it is important that
customers can see and feel the
print results in the flesh before
printing for the first time.

Download & install our ink swatches

METALLIC GOLD FLURO GREEN U FLURO YELLOW U FLURO PINK 806 U FLURO ORANGE 805 U BLACK U GREY 403 U

SPECIAL INK! FLUORESCENT INK! FLUORESCENT INK! FLUORESCENT INK! FLUORESCENT INK!



OVERLAYING

Riso inks have a translucent
quality that work well when
overlaid and blended with other
inks. Many more colours can be
achieved this way.

WARNING

When producing prints with
multiple colours/heavy coverage,
unwanted marks can occur by
the feed tire, picking up ink from
the previous print, and
transferring it onto the next
sheet of paper being fed.
These marks can be difficult
to remove. We therefore
recommend no more than 4
passes,
or 2 when using heavy
coverage or darker colours.

TOP TIPS

Use a rubber to remove any tire
marks or unwanted smudges.

Layout: Leave one area (either
top or bottom) of A3 sheet clear
or with little coverage.

Switch on the ‘MULTIPLY’ effect in the Transparency
tab when designhing in adobe to see a mock up of how
it will print, and download our swatches to integrate our
pallet into your workspace for further experimentation.

38 £ TRANSPARENCY |
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PAPER + INK

Examples of orange ink printed onto
various papers. Please note that ink
colours can change depending on what
paper they’re printed on.




& Printing On Dark/Black Papers

Unlike the other riso inks, Metallic Gold prints great on black and
dark paper, as well as white. It has a thicker consistency and
higher opacity - so keep this in mind if using it in overlaid artwork.

As we have a two colour machine, we print two layers together in
the same pass. The image below shows artwork printed in black +

- 75%

GREY
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FLU. ORA.
ORANGE
RED
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FLU. PINK
VILOET
PURPLE
FED. BLUE
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Metallic Gold ink. The layers were printed with the gold [50%

underneath - but the results look as though it's ontop. This is how

the metallic gold behaves when printed/layered with another GREY

colour. MET. GOLD
FLU. YEL.

If you want to avoid this, and let the other ink stand out; you could YELLOW

potentially knock out areas where the gold overlaps, or reduce the LU, ORA.
ORANGE
RED
BURG.
FLU. PINK

VILOET
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GREEN
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PAPERS

RISO inks print well on most uncoated
papers, as it can be absorbed onto the
surface and allowed to dry (unlike printing

onto coated or trace papers).

WEIGHTS

Generally 80gsm - 250gsm is

the standard weight bracket

that the riso will respond well
too.

We stock tested papers at
60gsm - 350gsm but these
can be a little tricky at times
as they are prone to sticking
to the stencils or jamming,
etc. We are happy to use
them for shorter runs, and
with low ink coverage.

Download our A3 Paper
Scans to mock up
artwork and make your
paper choices.

BESPOKE PAPERS

If you have a particular
paper request, and the
quantities are high, we can
order it in for you.

For lower runs (under 250
A3 sheets), we ask that you
organise your paper
independently, as this often
works out more cost
effective.

We'd prefer to test a new
paper first, so please send
us a few sheets so that we
can ensure ink drys well,
& the machine feeds it
smoothly.

When ordering, add an
additional 15% extra to the
required quantities to cover
any misprints.

Our UK suppliers include:
GF Smith, Fenner,
Paperback, & Antalis. We
carry extensive sample
books in our workshop.



PREPARING FILES

For print, artwork files should be:

1. Flattened PDF (no layers or transparencies)
2. Set to Greyscale / B&W

3. Resolution = 300dpi | Size = A3

4. Each colour layer saved as a separate file

UN-FLATTENED FLATTENED
All images and content within files must be set at | - | o »
the size intended for printing, and 300dpi.

) ) ) If your artwork contains effects such as drop shadows, the riso will
The risograph will automatically convert your pick this up and print visible boxes accross your artwork. These

images into halftones, so there is no need to set elements need to be flattened and rasterised before print.
bitmaps prior to print.



COMMON PROBLEM:
FILES NEED ‘CLEANED’

If artwork has been previously scanned in, or has textures
apllied, the riso may pick these up and print these more
visibly than it appears on screen. Zooming in on Photoshop
for example, might help you spot any problem areas before
you send the final files. You should tidy these up unless you'd
like them to print visibly as pictured on the right.
Ammending the contrast or using the eraser tool can ‘clean’
these issues up.

Spotting these issues in advance and correcting any
problem areas (removing any ‘dirt’) is your responsibilty. Ob-
visouly if we see anything on our end while processing your
files, we'll flag this up to you, as we want you to have the
best possible print. As we've not been involved in the art-
work generation, or know your preference/opinion of how the
outcome should appear, it’s hard for us to gauge what is
sometimes deliberate or sometimes an oversight.

How was the Portice
d San Luca?

We are not responsible for the artwork you send, and we s
process print your files to the best of our ability. | The walk it thought to -

R EXERXD SXERR.



FLATTENING FILES IN ADOBE... e

So for this procedure,
use a copy of your PDF.

Some PDF files contain layered content + transparencies if they are Using Adobe lllustrator:

created by using applications such as Adobe InDesign or lllustrator.

When printing PDFs that contains layered content, the riso will read - Hide, or de-select elements that can
each element uniquely and the printed result won’t correlate to the remain as vectors.

on-screen art. The riso will pick up on these and print them
awkwardly, resulting in visible corruptions. This is why it’s important
to Merge / Flatten layers before sending, so that all transparencies
or effects become part of the artwork. - In the ‘Object’ menu, click on ‘Flatten
Transparency’

- Select only the elements that are
effected, to be flattened and rasterised.

- In the pop up menu, set a custom

Merged layers acquire the properties of the layer Preset to match the following.

into which they are merged. Flattening layers
discards any layer content that isn't visible onscreen.

Save Adobe PDF

:doysojoyd aqopy 8uisn

Adobe PDF Preset; [High Quality Print] (Modified)

Standard: None v Compatibi

For Acrobat 7, 8 or later: o sy
Compression Description: [Based on "High Quality Print’] Use th
1. Make a backup copy of your PDF ﬁ|e Marks and Bleeds for quality printing on desktop print

be opened with Acrobat and Adobe |
Output

2. Open your file and choose Advanced > PDF Optimizer. Advanced

Security Options

3. Click the Clean Up tab OR If asked whether you want to
save and continue, click Yes

28ew| usyje|q, 303|9s pue nuaw JakeT], ayj 03 on -

1
SURImstyl Preserve lllustrator Editing Capabilities

[ Embed Page Thumbnails
4. |If asked, Select: Discard User Data Optimize for Fast Web View

Discard Hidden Layer Content + Flatten Visible Layers [ View PDF after Saving
and then click OK

5. When prompted, save the Optimized PDF with a new name

6. Open the Layers panel (choose View > Navigation Panels > Layers)

aeosAain, s| a8ew] JnoA ains ayew pue spopy, < 28ew|, o3 o8 ‘Ajeuld -

(3

7. Click the Options menu, and select Merge Layers or Flatten Layers - Finally, in the ‘Object’ menu, click on

8. Save the PDF file and try to print it. ‘Rasterize’ and set it to greyscale + 300ppi.




FULL BLEED POSTERS
A 3 L AYO U T For a full bleed finish, we can crop your posters once they’re

done printing.

A3 PAPER If you'd like to make your poster full-bleed, we’ll need you to
add 4mm bleed to all sides of the artwork, whilst retaining it

UNPRINTABLE AREA within the printable area, so no important artwork is lost.

PRINTABLE AREA The cropped poster will be approx. 270 x 393mm in size

There is no need to add crop marks or registration marks as this
will only reduce the finished size of your file, by making room
for them within the printable area).

BLEED IS EXTRA IMAGE AREA,
USED TO ENSURE A CLEAN TRIM

A3 PAPER
UNPRINTABLE AREA
BLEED

FINISHED ART AREA

This portion of the card will be lost
when cut to the final size. We use it
to ensures no white edges are left
exposed, and the colour, image or
design continues right to the edge
of the card.

Keep this area clear of all
sensitive and important

information that you don’t want to
be trimmed of by our guillotine.

The RISO cannot print full bleed A3 artwork
Please leave a 10mm clear border on all prints




CARDS + FLYERS LAYOUT

==A3 PAPER—— IS IUIoI0 REDUCED

A5 A5

BLEED (4mm)
A5 PRINT

. CROP MARKS s

REDUCED REDUCED

A5 A5

REDUCED
A4

REDUCED
A4

CROPS ARE
BLEED HAS BEEN TOUCHING
ADDED, & CROP
MARKS ARE
POSITIONED
AWAg ggh?llsv'l? THE
Amm bleed
Is required
on any print
NO BLEED HAS
BEEN ADDDED
& CROPS ARE
TOUCHING
NO BLEED HAS
BEEN ADDDED

that will be
BUSINESS CARDS

trimmed to
size.

Crop marks
should be

added too:

A3 PAPER

Unprintable Area

Although the A4
spreads are
positioned across
the full area of the
A3; there should
be no artwork or
content occupying
this unprintable
10mm border area.




REDUCED

REDUCED
REDUCED

A3

REDUCED

AL
REDUCED

REDUCED
REDUCED

'\

REDUCED REDUCED




BUSINESS CARDS

TRIMMING
OPTIONS

Our guillotine can trim all of the following formats, as
well as custom dimentions. Just set your crop marks
acordingly and we’ll trim to match. Measurements may
be a few mm out due to the nature of the machine, and
movements in the riso’s registration.

N.B. Only the diagrams in BLue require crop marks on
the page. Download our adobe templates for layout
guides for all the following formats.

Ab
2
A RED?JéCED d
A <S5
s
’/A\&'// REDUCE
: \\\\)\\ Ab REDU6CED ?
\%\'/ REDUCED \\\Q .
)‘/// ////I\&\‘\\ S
%

2% 245




NAMING FILES

We need a file for every colour youd like to print with,
plus 1 additional file of a full colour digital proof.

Please specify the colour you'd like the file printed in.
(the name or pantone will do)

For example, a two colour poster will have 3 separate files:

Peter_Red_A.pdf Peter_Blue_B.pdf Peter_proof.pdf

If you are creating artwork with overlays, feel free to indicate which
layer you'd like printed first (A for first, B for second etc).

We generally aim to print the lightest colour first, and darkest/heavi-
est coverage layer last, to reduce track marks, so we’'ll discuss this
with you if it conflicts with your desired order.

For double sided artworks, include sides:

Peter_Sidel_Red_A.pdf
Peter_Sidel_Blue_B.pdf
Peter_Side2_Red_A.pdf
Peter_Side2_Blue_B.pdf
Peter_Sidel_proof.pdf
Peter_Side2_proof.pdf

oo s WD~

For multiple artworks, include artwork titles:

Peter_Drawing_Sidel_Red_A.pdf
Peter_Drawing_Sidel_Blue_B.pdf
Peter_Drawing_Side2_Red_A.pdf
Peter_Drawing_Side2_Blue_B.pdf
Peter_Drawing_Sidel_proof.pdf
Peter_Drawing_Side2_proof.pdf

oo AW

Peter_Painting_Sidel_Red_A.pdf
Peter_Painting_Sidel1_Blue_B.pdf
Peter_Painting_Side2_Red_A.pdf
Peter_Painting_Side2_Blue_B.pdf
Peter_Painting_Sidel_proof.pdf
Peter_Painting_Side2_proof.pdf

oo AW

Without the proof file we won’t be able to see what
results you're anticipating, and therefore can’t point
out any potential issues or mistakes. You don’t need
to match the colours exactly,
It's just to give us an feel for your artwork.



Simply changing the document settings to
O PAC I I I E S ‘greyscale’ in photoshop for example, Peter_Red_A.pdf Peter_Blue_B.pdf
might not always be sufficient. Especially - -
when converting lighter colours. NN e

20% - o .
BLACK™ . .= FOR PRINT
All files are sent to the printer in grayscale, and colours are S e e
added within the printing process. oo B AGK S o gt
BLACK ‘ - e B e B
To print solid areas of colour, artwork should be set to ST e
registration black, which is often indicated by the 100% ‘ |

BLACK

cross-hair symbol and can found in SWATCHES panels: ‘ —|—

100% -
BLACK =——

$ Swatches

B G | teco0 bk

4
(11

7] Nonel J 7z
B (Registration] z
[] tPaper]

B sk @0
B c=100M=0Y=0K=0

© N

20% L
INK =

The riso is very sensitive and will register different shades of
black which will be visible in the printed output. ] S0%

So please insure all tones of black have the same settings if INK ‘ gl
you intend their output to be the same. TR

100%
The different opacities of greyscale, are represented as e ‘ _I_
different opacities of your chosen colour: ‘

' 100%

GRESCALE ARTWORK: RED RISOGRAPH PRINT:




INK COVERAGE

Too much ink coverage can cause paper to stick to the sten-
cil/drum, which can jam the machine and tear up the paper.
This will stop us being able to print, and will require the art-
work to be amended by you, and a new stencil to be sent -
costing £15 per colour.

Heavy ink can also cause extra splashes, needle marks and
smudges on prints, as the paper is separated at an uneven
rate. Large areas of ink set between 90-100% can result in a
visibly varied print consistency due to ink flooding across the
stencil.

Track marks from the feed

tire can appear when prints
make multiple passes.
Marks can also appear on
double sided prints, from
pressure impressions that

100%
can mark the next sheet of Solid Ink

stacked paper if there is

ink in this area.

*If marks do appeatr,

most can be minimised _
with a rubber! (looks like a scratch)

NEEDLE MARKS

The riso can’t print
100% ink density across
100% of the paper.

PLEASE NOTE:
These correct
layouts may still
have a chance of
needle marks.

Large areas of solid
colour can also cause
problems! Especially
around the edges and
top/bottom of stencil
(keep one end clear)

' 75%
BORDER

v.f

100% v
BORDER >A<

PRINTING heavy bor-
ders around the edge
of the page will not
work.The paper will
stick to the drum due
to the amount of ink
around the lead edges.
Either reduce the
opacity to 75%, or
create blocks to stop
the border at both
lead ends of the page.

85%
BORDER

v,




IN K COVERAG E We can advise you

further if we feel you
artwork might suffer

Reduce the chances of ink trans- :
from ink coverage

fer, and ensure a cleaner prin&e—\/
- Print using 50% coverage across

the entire page. We often recommend
inverting artwork, or
-Avoid large areas of ink at the using a coloured paper

instead of printing a

pPaper feed area. coloured background.

- Limit the number of inks (passes
made through the machine)

o (,‘\\\C\L / SChe
-Reduce large areas of solid ink S3 Y

to a70-85% tint

-Ask to have your prints ‘Blotted’™

/‘
FEED TIRE

PAPER

B — \EEDLE

These issues are especially
important to note if prints
are double sided or have

multiple layers.

TOP TIP *

Opt for thicker
paper when
printing with

lots of ink!

*On exiting the machine, prints stack on
top of each other: If the artwork is ink
heavy, it can mark (create an echo on)
the reverse of the prints.

If you require a cleaner finish, you can

request that we intersperse pyints with
blotting paper at an additiona) cost.

PRINTS




GRADIENTS

RISO doesn’t print 0-10% ink well..

This is mainly an issue when printing
gradients as the range is very visible.
For best results - set gradients to range
between 10%-90% ‘K’ (black).

For Photography that has large areas cof@% 0%
taining 0-10%

content, results can look better
if the lightest part is increased
to 10%. This will prevent the
unappealing ‘drop off’ that
happens
between 0-10%.

Setting your darkest tone to 90% is only nec-
cessary for large areas of ink coverage. Setting it
to 90% won't visibly change the appearance
much, but will avoid any ‘tide’ marks or flooding
appearing. These are

visible inconsistencies accross the surface.



TEXT / TYPE TEXT

100% K
Text always prints best when set to using registration
black and in vector form; which is created when
working from lllustrator or InDesign.

KNOCKOUT TEXT

_
o - delloVHEN= EHEY '
Use normal black (100% K) for type 14pt or above to avoid GOP . . « . T LB TEXT

excess ink. Aﬁ’al;ﬁéllﬂlliléll I

80% K

KNOCKOUT TEXT

et
.....

Never create type in Photoshop, as it rasterizes it as an
image, and the printed result looks rough around the
edges instead of being clean and crisp.

To keep text & line art as vectors when exporting
artwork; do not rasterize.

Text Point Size = 10 pt KNCKOUTTEXT

Text Point Size = 9 pt

Sl For Knock-out text, do not

Text Point Size = 7 pt : > 0.75 pt set type below 8pt The
printer isn't reading it as

B text, but rather the pixels

A/\ around the text, so be care-
0.5 pt € .
ful with percentages of

IV.I|n|mUTn (recomr.nejnded) text = 7 PT (reg. black only) A\ colour: if surrounding ink is
Line Thickness minimum = 0.25 PT (reg. black only) e \ too wet/ heavy, it can flood
& P e 0.25 pt the text gaps, and too pale
. . A p
The machine will struggle to accurately reproduce type \ LX T can result in jaggy edges.
smaller than 6pt & we would recommend sticking to 7pt | e /

and above. Smaller text will also have legibility issues. S



STENCILS

Switch on the ‘MULTIPLY’ effect in the Transparency
tab when designhing in adobe to see a mock up of how

your layers will print.

Download our swatches to integrate our ink pallet into
your workspace for further experimentation.

5 Vo

TOP TIP o
When printing
images, open up the
mid-tones and
ensure there is good
contrast throughout.

There is no need to
apply the halftone Increasing the width/borders on
effect to your art- . .

graphics will help layers overlap

work as the riso will i
do this for you. and ensure a full colour fill.

CMYK EFFECT:

The CMYK printing process can be imitated on the

riso; by using the yellow and black as normal, and sub-
stituting the Magenta for Fluro Pink and Cyan with our

Blue. Alternatively other inks can be substituted to
create your desired pallet depending on how vibrant
you'd like the output.

We have invested a lot of time and expertise in this

area, and can separate artwork for you - ready for the

4-colour process - at a flat rate of £30 per A3.

PINK.pdf TEAL.pdf ORANGE.pdf

X =N

Greyscale Stencils

Colour Prints

Overlay Results

PINK + TEAL ORANGE + TEAL PINK + TEAL + ORANGE



Greyscale Stencils

Colour Prints

Overlay Results

OVERLAY STENCILS @ CUTOUT STENCILS
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IMPERFECTIONS

Riso printing doesn’t suit every job due to it’s
unique results, so being open to the quirks of the
machine is an important part of printing with us.

The best outputs are usually designed with the
riso process in mind from the start, rather than
re-working artwork afterwards (although not in
every case!).

As the riso isn’t perfect like a digital printer; your
finished prints will have a different look and feel to
what you see digitally on your computer screen.
Our soy inks have similar qualities to newspaper
ink, and can smudge if handled a lot, and each
print will differ slightly from one to another, with
small imperfections in registration and ink
coverage.

All these quirks can be minimised by following our
print guide and finally, neatened up at the end
with the help of a rubber!

INK TRANSFER

Prints are stacked on top of each other when
they come out of the Riso so heavy ink will
cause transfer between the prints. Guillotining
applies extra pressure and can also create
additional transfer marks. We offer an
additional service to intersperse blotting
sheets in between prints as they come out.
This keeps the reverse side super clean. Riso
ink can smudge easily so is best to avoid
having large areas of solid colours for flyers
and book covers. Use spray fixatives on prints
with heavy coverage to helps to minimise
smudging.

PRINT MARKS

There will be print marks,
especially when printing
more than two layers,
artwork that uses heavy
ink, and/ or is double
sided. Generally, the
cleanest, crispest prints
are; one colour, have light
coverage, and printed on
mid-weight paper.

DOUBLE SIDED PRINTS

Light marks will appear
when printing double
sided, especially if one side
is heavily inked, this is
caused by the pressure
roller. We will always print
the side with the lighter
coverage first. The internal
rollers can cause extra
marks from picking up ink
from preprinted image. We
recommend having one
side with lighter coverage.

5

TRAPp,
V.
G

TIRE MARKS

When producing prints with
multiple colours, unwanted
tire-marks can occur by the
feed tire picking up ink from
the previous print, and
transferring it onto the next
sheet being fed. When
producing double sided
prints, pressure marks
caused by ink transfer can
also occur if there is ink in
this area.

NEEDLE MARKS

A ‘pick off needle’ is used
within the riso to peel off
the print from the print
drum when printing.
Heavy ink will cause the
needle to drag across the
print leaving a scratch
line. Depending on the
artwork, their visibility
varies.

INK

When printing large areas
of solid colour - the
outcome can appear
Inconsistent in coverage.
Some ink discrepancies are
unavoidable and are an
inherent part of the
printing process.

REGISTRATION

As each colour is printed
one layer at a time,
registration will never be
100% accurate, so when
designing your artwork,

ensure there is room to
llow for 2-3mm shifting.
tend colour under line

work for neater results,
use trapping to avoid
white spaces, and avoid
small details that rely on
registration to be 100%



SUSTAINABILITY

RISOTTO takes great care in minimizing its
impact on the environment; from daily studio
operations, to waste management, and
sustainable paper supplies. We up-cycle test
prints/leftovers, and recycle everything else.

Riso printing in itself is a highly energy
efficient and sustainable printing method,
making for an ethical product, unmatched by
other printing methods.

The cold process consumes little energy, and
the riso prints with soy based inks. Unlike
litho printing, it only takes a few printa for the
stencil to be fully inked and ready to print. It
uses little electricity and eliminates the need
for up to 100,000 litres of water and 10,000
litres of alcohol (per year) consumed by a
typical mid-size printer.

We make all of our paper goods in our
zero-waste studio in Glasgow, keeping our
transportation costs and fuel consumption to
a minimum, and reinforcing our commitment
to sustaining the power of small-scale artisan
quality, as an alternative to mass production.



VAT does apply to
some printed products,
but not all of them.

VAT is charged when

a VAT-registered
business sells to
another business, or

a non-direct customer.

Here are two basic lists
of what printed
products carry VAT and
which do not. For a full

list of printed items and
their VAT status please VATABLE
visit the HMRC site. e eeptancelcards

- Business cards
- Calendars

ZERO RATED - Certificates
- Books - Compliment slips
- Booklets : C0t:|pons
- Delivery notes
- Brochures B
- Diaries
- Catalogues - Folders
- Directories - Forms
- Flyers - Invitations
- Journals - Invoices
- Magazines - Labels
ke - Eostcards
- Sheet Music o8 er.s .
- Questionnaires
- Newsletters - Stationery
- Newspapers - Stickers
- Pamphlets - Tickets
- Price lists - Transparencies
- Timetables - Envelopes

PRICING

Quotes are calculated

first by the number

of colours/stencils used,
then with print quantity
and paper selection added
on the end. Like screen-
printing, the initial set-up
is where most of the pro-
duction time is spent, and
cost is weighted.

Therefore the most
economical jobs are ones
that use few colours/
stencils but output high
quantities, and the more
expensive jobs involve
many colour stencils,

at a low print quantity.

The riso is designed to be a
duplicator - so once the art
work is set up, it's pennies
per print. Also - please note
that no run is too small, and
we often print one-off’s!

No. of Colours

No. of Prints
100 250 1000

200 x 2 colour
100 x 3 colour
65 x 4 colour

Printed on our 100gsm newsprint (house stock) | includes VAT



QUOTES

The riso is an A3 printer - so
everything is sent on A3 sized sten-
cils, and printed on A3 paper.

As the complexity of all print jobs
vary, we have no rigid price list and
we quote based on each job individ-
ually.

If you can provide details of the fol-
lowing - we'll get back to you with
accurate estimates:

A3 PRINT QUOTE

Number of colours on SIDE A: (e.g 3 colour)
Number of colours on SIDE B: (e.g 0/Blank)
Copies: (e.g 250)

Paper: (e.g 120gsm cairn white)

Regardless of the final product, all quotes
are generated from the A3 pricing struc-
ture, so if you want to know the price for
50 A4s, we'll quote for 25 A3 prints + trim-
ming. The A4 prints should be laid out 2UP
per A3 sheet. Use our adobe templates to
ensure best results.

DELIVERY
Local pick up = Free
UK Recorded = £15
EU Recorded = £25
Rest of World = £45

EXTRAS

FAST TRACK = £15

If you need your job ASAP we can try
to prioritise your job, if we can.

BLOTTING

If you require a cleaner finish, opt for our blotting service. Each print is
interspersed with blotting paper, separating wet prints from one another, on
their final pass through the machine. This process helps to soak up extra ink,
protects the back sides from additional ink transfer, and speeds up drying
time. It is recommended for prints with heavy ink coverage, or trimmed
products like Cards. Prices dependant on quantity.

PRINT PROOFING:

Due to the RISO process, print proofs aren't common because most of the
overall job cost is in the initial 'stencil making’ and set-up of the job. A proofing
service therefore involves a fee of £15 per colour stencil tested. Please bare in
mind this process will incur additional turnaround time, as the proofs will either
be posted out to you, or a timetabled appointment will be set for you to come
in to see the prints first hand. For very large or colour critical orders, we
recommend opting for a printed proof, as this is the best way to ensure
expected results.

HIRE A DESIGNER:

We specialize in connecting our clients with vetted riso-design talent to help
bring your print projects to fruition. Tell us all about your project, and we'll
review your information and pair you with a hand-selected designer who will
work to bring your vision to print.



TURNAROUND TIMES

Riso printing takes more time than you'd imagine.
It’s fast once things are set up and running, but
unexpected issues (like technical failures or paper
jamming) happen on occasion and slow everything
down. Print checks, drying time and alignment are
also important to us, so we take time to produce
the best prints.

So, the more layers you print the longer it takes.

1 colour prints take 24 hrs.
Add 24 hrs for each additional
stencil, to calculate an
approximate turnaround time.

Also - we're closed weekends!

If you're tight on time, we can speed things up by shortening the drying
time between layers, but this can result it additional print marks, so con-
sider this when proposing deadlines.

Our Blotting Service (Extra paper interspersed to soak up extra ink

and separate prints from one another) can also speed up drying time.

Ordering in specific paper will add roughly 5-10 working days.



AMENDMENTS + PROBLEM FILES

Once printing has started, there will be a £12 fee for every new
stencil or amendment made.

Please make sure you've read through our print guide and
terms thoroughly before going ahead with printing.

Sometimes, we can’t see any problem with your file until it’s
been printed. Usually this is because file has not been flat-
tened properly, small text has not been set to registration
black, text has been done in photoshop - and it appears pix-
elated o artwork has not been cleaned properly and looks
dirty’ or pixelated.

If you have edited any illustrations or scanned text in photo-
shop - please take a look at this printed image as a potential
outcome, if artwork has not been ‘cleaned up’ fully.

If you have any effects such as drop shadows, or your files are
made up varying elements - please take a look at this image to
flag printed results of un-flattened artwork.

If you have gradients in your artwork - check this quick refer-
ence out to compare your artwork against, and tweak the scale
to suit your desired outcome.

These issues are your responsibility to check and correct, and
we cannot be held liable for this artwork set up.

Please make sure you and your files tick all the boxes:
You have read our Print Bible and fully understand the process

Each file is A3 in size

There is No artwork or content out with the printable area
Each file has been set to 'Greyscale' mode

Each file is under 10MB

There are no transparencies or effects; your images are 'FLAT.

Small text and fine lines/logos have been set as 'registration
black' and have not been rasterised.

If you are unsure of anything, please ask us for advice!
We can also ammend your files for a fee.

Our studio time is charged at £30 per hour.



TERMS + CONDITIONS

* All print work to be paid for before it leaves the studio unless otherwise
agreed.

* A confirmed job request will be taken as order confirmation.

* Ordering prints or products from RISOTTO means that you have read and
accepted our Terms & Conditions.

*If a job is later cancelled by you, any costs, such as paper ordered in,
incurred to us will be charged for.

*Work over £1000 in value requires a 50% deposit before printing can
commence.

* You acknowledge that all details which you provide to us for the purpose
of ordering goods are correct, that the credit or debit card you are using is
your own and that there are sufficient funds to cover the cost of the order.

* Please ask about turnaround times. They change depending on the time
of year.

*We accept no responsibility for missed deadlines if artwork is incorrectly
submitted or needs to be amended.

* RISOTTO reserves the right at any time to revise the price of items with-
out notice.

* All orders are subject to acceptance and availability.

*RISOTTO Studio Ltd. reserves the rights to modify, alter, terminate or
discontinue any discounts or promotions at any time for any reason what-
soever without notice.

* You are responsible for making sure that artwork that you send to print is
accurate and appropriate for publication and printing. Do not submit any-
thing you know to be unlawful or harms the rights of others.

*We will check the design and file set up to ensure your order is printable,
although we do not monitor the content.

*We cannot guarantee that paper quoted in initial email correspondence
will be available immediately.

* Every effort has been made to accurately display our products
with the correct product information and colour, however we
cannot guarantee that all monitor display accurate colours of the
products when delivered as each monitor display differs.

* All sizes and measurements are approximate. We do try to make
sure these measurements are as accurate as possible, however we
do advise customers to consult the sizing charts provided on the
website. Please note that sizes may differ between some items.
*We are unable to accept responsibility for work that is not col-
lected within six weeks of completion.

If a proof is not provided (jpeg, pdf) then we will not print the
work until one is received.

We are unable to accept responsibility for work that is not col-
lected within six weeks of completion.

*We use the Royal Mail and couriers such as UPS and DPD for
orders within the United Kingdom.

*We will use the courier service requested upon booking of a job
and we will insure it as appropriate. In the unlikely event of delay or
loss in the post or by a courier, we will not be held liable under any
circumstances for consequential loss resulting from third party
actions but will always do our utmost to resolve any transit issues.
*We aim to dispatch all orders (excluding out of stock items) within
3 working days of confirmation the funds for your order have been
cleared.



RISO PRINT/
PRODUCTION
DISCLAIMER

- The Risograph is not perfect like a inkjet or laser printer,
and inconsistencies are inherent to the process. The
prints will look different from what you see on your com-
puter screen.

- There will be print marks, especially when printing more
than one layer or double sided, and registration will not be
perfect, with each print varying slightly from one to the
next.

- Part of the appeal of this process should be these imper-
fections coupled with the hand printed quality, as this is
the intrinsic nature of the machine and its output.

- Unlike most methods of printing, Risograph spot color
inks do not conform to a pantone standard (the provided
Pantones are approximates. Additionally, the inks are all
slightly translucent so finished colour will vary depending
on what paper you print on.

VISITATION
NOTICE / PRO-
JECTS

RISOTTO is a small operation that takes on bespoke print pro-
jects in the margins of our primary function as a reprographics
service and stationery co. We strive to work efficiently, deliver-
ing a high quality service across all aspects of our work, and are
therefore only able to take on a few bespoke jobs at a time,
scheduled on a first-come, first-serve basis.

For the time being, we have decided to stop taking any other
appointments. We regularly receive requests to visit the studio
(to see samples, demonstrations or to discuss a project) and
currently don't have the capacity to offer this. We have worked
hard to deliver a online resource that should cover every aspect
of your enquiry, so we urge you to explore our archives and, if
you have any questions, please get in touch.

Email is the best way to reach us, as we're rarely by the phone.
We do our best to get back to all inquiries in a prompt manner,
but may be overwhelmed during busy spells. We will reply to
your message within 3 working days at most.

We can be reached via e-mail at info@risottostudio.com.

Delivery Address: RISOTTO, The Glue Factory, 22 Farnell Street,
Glasgow, Scotland, G4 9SE, UK
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A GUIDES =

the arrangement of pages
onto A3 printed sheets
(also known as parent
sheets) so they will be in
proper sequence once the
sheets are printed and
folded/bound together.

the numbering of pages
in a document.

document layouts of
pages put in the
sequential order a person
would actually read them.

document layouts of
pages put in the order
necessary to print them
so they will be readable

in proper sequence once
folded and bound.

folded paper that
represents a finished
project

a sheet of paper is printed
on its first side and then
turned over LEFT TO RIGHT
and printed on the back
side.

a sheet of paper is printed
on its first side and then
turned over TOP TO
BOTTOM and printed on
the back side.

a sheet of paper is printed
on its first side and exits
the printer; it is then
manually turned over and
re-enters the printer/press
to be printed on its back
side.

The most typical layout is
to have 4 pages per side of
a parent A3 sheet, meaning
each A3 sheet will have 16
total pages when printed on
both sides.

During printing, your pages
are printed on A3 paper
that holds (depending on
your finished book size) 4,
8,16 or 32 pages - all
multiples of four.

After printing, these
sheets are folded, cut
and/or bound into a
finished book.

Each side of a sheet
counts as a page. If your
page count is not a
multiple of four you would
be left with blank pages
throughout your book.

Imposition & Pagination

All projects with artwork
that goes to the edge of the
page require an extra 5mm of
artwork beyond the trim line
in all dimensions, known as
“bleed.”

This area will be cut off in
the final product, but
printing it ensures that all
printing goes to the edge
even with the standard riso
registration variances of
(3mm) inherent to the
printing process.

In addition, we recommend
keeping all text and
important graphics at least
10mm away from the edges of
the page, so that no content
is lost during the finishing
process.

www.risottostudio.com



e Creep

A GUIDES -

Creep is where the bulk of the paper in a
saddle stitched booklet causes the inner pages
to extend or ‘creep’ further out than the outer.
This is an exaggerated view of how important
content can get lost, where the more central
pages are the most vulnerable, and extend
beyond the edge the most.

The amount of creep depends on the size of
the margins, number of pages, and the
thickness of the paper. A booklet with few
pages and wide margins might not need creep
allowance because the difference after
trimming is not noticeable.

If creep is noticeable, copy should be
repositioned toward the centre of the spread

(especially for pages in the middle of the book).

Layout software (InDesign) can automatically
calculate creep allowance and adjust layouts
for creep — moving the page elements of
affected spreads in small increments.

CUT
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Imposition: 16pp, A5 Booklet

This is how a typical 16-page zine is paginated for riso Lay out your pages in the following sequence to ensure the
print. You can fit four pages per side of A3. Therefore, zine is paginated once cut, collated + bound.
you will require two sets of A3 double-sided prints.

Check out our print bible for more info on separating +
For each colour layer printed, a set of these files is saving artwork
required for print.

SET 1, SIDE A SET 1, SIDE B SET 2, SIDE A SET 2, SIDE B
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Imposition: 16pp, Folded A6 Zine

This is how a typical 16-page
folded zine is paginated for
riso print. You can fit eight
pages per side of A3. Therefore,
you only require one set of A3
double-sided prints.

Fold #2

<«—— Page Orientation

Lay out your pages in the
following sequence to ensure
the zine is paginated once
folded.

For each colour layer printed, a
set of these files is required for
print.

Check out our print bible for
more info on separating +
saving artwork.

You will need to make two cuts to
‘release’ the pages once folded.



Rsorod Imposition: 32pp, A6 Booklet

8 GUIDES =

When laying out your zine, drop your pages in the For each colour layer printed, a set of these files is
following sequence to ensure the zine is paginated required for print. Make sure you follow the page
once cut, collated + bound. orientation arrows if supplying artwork as ‘Portrait.
You can fit eight pages per side of A3. Therefore, Check out our print bible for more info on
you will require two sets of A3 double-sided prints. separating + saving artwork.
SET 1, SIDE A SET 1, SIDE B SET 2, SIDE A SET 2, SIDE B
W W ™ O~ N N ™ ™
- N ™ N N I N N
b o N
() ke | <t = NO — —
N N N~ Tp) b N o~‘ N
o~ oo N N o o o — —
— — < O
I~ on "ol 0| T w - —




RISOTTO {)

This is how a typical 24-page booklet is paginated for riso
print. You can fit four pages per side of A3. Therefore, you
will require three sets of A3 double-sided prints.

Lay out your pages in the following sequence to ensure the
zine is paginated once printed, trimmed, folded and bound.

SET 2, SIDE A
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Imposition: 24pp, A5 Booklet

For each colour layer printed, a set of these files is

required for print.

Check out our print bible for more info on separating

+ saving artwork

SET 2, SIDE B

|O~

|00

SET 3, SIDE A

NO

SET 3, SIDE B



